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Overview

Common Property Tables makes it possible for the reporting solutions that run on
Performance Insight to share the same customer, location, and node data. Sharing data
eliminates duplication, allows the database to operate more efficiently, and simplifies the
administration of report packs.

Installing Common Property Tables creates the following tables:

e K Customer for customers

e K Location for locations

e K Node for nodes

The data in these tables comes from three sources:

e Report packs

¢ The batch-mode import utility bundled with Common Property Tables

¢ The create and update forms bundled with Common Property Tables

Enhancements and Fixes

The following table outlines recent enhancements to Common Property Tables.

Version Release Date Enhancements/Defect Fixes

2.10 May 2003 HOSTS file property import (for easier mapping of
node name to IP address in K _node)

2.00 to 2.10 upgrade package

2.20 October 2003 PI Object Manager support; “create new” forms and
“update” forms

2.00/2.10 to 2.20 upgrade package

3.00 April 2004 Oracle support

two new directories:

$DPIPE_HOME \data\ImportData
$DPIPE_HOME \data\PropertyData

new nightly process:
CommonPropertyTables_delete_nodes.pro
upgrade package:

2.20 to 3.00
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Version Release Date Enhancements/Defect Fixes
3.50 August 2004 Modified TableAlias values
upgrade package:
3.00 to 3.50
3.50 November 2004 No changes
3.50 June 2005 upgrade package:
UPGRADE_CommonPropertyTables_to_3.5
3.50 March 2006 No changes
3.50 May 2006 No changes
3.60 April 2007 Partition maintenance
upgrade package:
UPGRADE_CommonPropertyTables_to_3.6
Defect fixes:
e QXCR1000283035
— Increase max rows for drop-down queries on
CPT Forms
e QXCR1000323690
— Package Manager hangs due to TNS problem
on Oracle
e QXCR1000374418
— CPT delete nodes SQL scripts need to delete
from K _CiscoVLAN_PortNonSt
e QXCR1000382190
— nightly delete nodes process errors out
e QXCR1000228205
— CPT delete node SQL script should delete from
FRSCPE 1315 before K_IFEntry_Disc
e QXCR1000382191
— sanconf: Unexpected message creating store.
e QXCR1000225079
— Oracle Port of ppGetNode_fk omitted essential
logic
e QXCR1000385614
— Issues with create_ppReportPackProcLog.sql
on Oracle
e QXCR1000353616
— Warning message in
delete_node_K_FRSCPE_FRSW_pvc.out
e QXCR1000192006
— Sybase version of ppGetNode_fk.sql has some
typos during logging calls
3.70 October 2007 Sybase 15.0.2 “path” > “keyword”
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Version Release Date Enhancements/Defect Fixes

3.90 February 2009 upgrade package:
CommonPropertyTables_Upgrade_to_39
defect fix:

e QXCR1000823079

— CommonPropertyTables_delete_nodes.sql fails
to delete nodes

Nightly Delete Process

Common Property Tables includes a nightly delete process:
CommonPropertyTables delete nodes.pro

The nightly delete process performs the following tasks:

¢ Rebuilds stored procedures, one per property table

e Deletes nodes from individual property tables

¢ Deletes nodes from ksi_managed_node

Although there are two versions of this process, one for Sybase and one for Oracle, the process
itself is database independent. The deletion of nodes from individual property tables takes
place in response to the user marking nodes for deletion in Polling Policy Manager. Deleted
nodes are listed in the log file maintained by Common Property Tables.

Sources for Additional Information

For information about the latest enhancements and any known problems affecting Common
Property Tables 3.90, refer to the following document:

e Common Property Tables 3.90 Release Statement

You can download manuals for the core product and the reporting solutions from this site:

http:/h20230.www2.hp.com/selfsolve/manuals

The user guides for PI are listed under Performance Insight. The user guides for report packs
and datapipes are listed under Performance Insight Report Packs. The entry for each user guide
indicates the month and year it was posted to the web. If a manual is revised and reposted,
the date will change. Since revised manuals are reposted from time to time, be sure to
compare your PDF to the web edition and download the web edition if it is newer.
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2 Package Installation

This chapter covers the following topics:
e Guidelines for a Smooth Install
¢ Installing Common Property Tables 3.90

e Package Removal

Guidelines for a Smooth Install

The report pack CD contains the latest report packs, datapipes, and shared packages. When
you insert the CD and launch the package extraction interface, the install script extracts
every package from the CD and copies the results to the Packages directory on your system.
After the extract finishes, the install script prompts you to launch Performance Insight and
start Package Manager. Before using Package Manager, review the following guidelines.

Software Prerequisites

Common Property Tables 3.90 requires:
¢ Performance Insight 5.40
e All service packs available for PI 5.40

Upgrading to Version 3.90

If you are running an earlier version of Common Property Tables, you can upgrade to version
3.90 by installing one upgrade package. When upgrading Common Property Tables, keep these
rules in mind:

¢ Do not install other packages (a report pack or a datapipe) when you upgrade Common
Property Tables. Install the upgrade package for Common Property Tables and only the
upgrade package for Common Property Tables.

e  When you install the upgrade package, you will be prompted to accept or disable the
Deploy Reports option. The forms that come with Common Property Tables will not deploy
to the Application Server unless you accept the default for Deploy Reports.

e Ifyou are running PI on multiple servers, install the upgrade package on every server
that is running Common Property Tables.

Directory Structure

When PI was installed, the installation program created the following:
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e A directory for PI; the directory name is OVPI
e A directory for packages available for installation
e An environment variable that points to the OVPI directory

On a UNIX system, the directory for PI defaults to /0VvPI. On Windows, the directory for PI
defaults to C: \OVPT.

The Packages directory is where Package Manager looks for packages awaiting installation.
This directory contains one sub-folder for each package copied from the report pack CD. When
you run Package Manager, any package currently in the Packages directory will show up as
install option in the Package Selection window.

l:l docs
{:I Forms
B0 html
|:| images
|:| jre
"|:| jrun
- b
-1 Ing
{:I mibs
{:I packages
|:| reporks

The environment variable is {DPIPE_HOME}.

ImportData and PropertyData Directories

Installing Common Property Tables creates two directories:
e SDPIPE HOME\data\ImportData
e SDPIPE HOME\data\PropertyData

All report packs that rely on Common Property Tables use the PropertyData directory.
They import flat files from the PropertyData directory and they export flat files to the
PropertyData directory.

Installing Common Property Tables 3.90

If the packages on the report pack CD have not been extracted yet, insert the CD and follow
the instructions for extracting packages. On Windows, the instructions appear in a menu that
opens automatically; on UNIX, mount the CD, navigate to the top level directory for the CD
drive, and run the setup command.
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After the install script copies packages to your system, you will be prompted to start Package
Manager. If the packages on the report pack CD were extracted, but Performance Insight is
not running, begin at step 1. If you just extracted packages from the report pack CD and
Package Manager is running, begin this procedure at step 4.

1
2

10

n

12
13

Log in to the system. On UNIX systems, log in as root.
Stop OVPI Timer and wait for processes to terminate.
Windows: Select Settings > Control Panel > Administrative Tools > Services.
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop

Open the Management Console and start Package Manager. The Package Manager
welcome window opens.

Click Next. The Package Location window opens.

Click Install. Approve the default installation directory or select a different directory if
necessary.

Click Next. The Report Deployment window opens. Accept the default to deploy reports.
Type your username and password for the PI Application Server and click Next. The
Package Selection window opens.

If this is a new install, click the check box next to:
CommonPropertyTables

If you are upgrading, click the check box next to:
CommonPropertyTables_Upgrade_to_39

Click Okay.

Click Next. The Type Discovery window opens.

To run Type Discovery immediately after package installation, accept the default and
click Next. The Selection Summary window opens.

Click Install. The Package Installation window opens and the install begins. When the
install finishes, a package installation complete message appears.

Click Done to return to the Management Console.
Restart OVPI Timer.
Windows: Select Settings > Control Panel > Administrative Tools > Services.
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Package Removal

You may uninstall Common Property Tables. However, because Common Property Tables is a
prerequisite for many report packs, you are going to uninstall all of those report packs if you
uninstall Common Property Tables.

Package Installation
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If you just installed the upgrade package, you cannot return to the previous version of
Common Property Tables by removing the upgrade package. Instead, to return to the previous
version, uninstall the new version and then re-install the version you were running.

Follow these steps to uninstall Common Property Tables.
1 Login to the system. On UNIX systems, log in as root.
2 Stop OVPI Timer and wait for processes to terminate.
Windows: Do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
UNIX: As root, do one of the following:
— HP-UX: sh /sbin/ovpi_timer stop
— OSun: sh /etc/init.d/ovpi_timer stop
Start Package Manager. The Package Manager welcome window opens.
Click Next. The Package Location window opens.
Click Uninstall.
Click Next. The Report Undeployment window opens.
Click Next. The Package Selection window opens.

© N o000 0 A W

Click the check box next to Common Property Tables and click Next. The Selection
Summary window opens.

9 Click Uninstall. The Progress window opens and the removal begins. When the removal
finishes, a package removal complete message appears.

10 Click Done.
N Restart OVPI Timer.
Windows: Select Settings > Control Panel > Administrative Tools > Services.
UNIX: As root, type one of the following:
HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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3 Import and Export Utilities

The user input forms described in the previous chapter are suitable when you are dealing
with a small number of customer, location, or node objects. For a large number of objects,
entering data using a batch process is more efficient. The Common Property Tables package
includes import and export utilities for this purpose.

The import utility imports the four property data files described in Chapter 5, Property
Import Files. The import utility runs once a day, automatically. The default run time is
midnight, but you can change it to any hour of the day. You can also run the import utility
manually, ahead of schedule. Run the export utility as needed.

Import Utility

The import utility performs three tasks:
e Reads property data files containing records for the elements to be updated
e Stores the data in temporary tables in the database
e Uses imported data to update the following tables:
— K Node
— K Customer
— K Location

If the data in the property data file is for an element (node, customer, or location) that already
exists in the property table, the data in the property table is overwritten by the imported
data. If an element does not exist, a new row is inserted in the appropriate property table.

The default directory for property import and export files is:
{DPIPE_HOME}/OVPI/data/PropertyData

You never need to have all four property files in this directory. This directory can be empty, or
it can contain just one or two files. When you want to update just one property table, edit just
one file and store just one file.

To run the import utility manually, before the utility is scheduled to run, do the following:
1 Open a command prompt at the system level.

2 Navigate to the {DPIPE _HOME}/scripts directory.

3 Type the following command:

trend proc -f CommonPropertyTables importdata.pro

17



Export Utility

The export utility exports the contents of property tables as tab-delimited flat files and stores
these files in the default property export directory or in a directory that you specify. The
export utility is based on a process known as trend_export. This process determines which
columns to export from the database and generates tab-delimited files in the proper directory,
appending each file name with a timestamp, as follows:

® CommonPropertyTables Customer.dat.<timestamp>
® CommonPropertyTables Location.dat.<timestamp>
® CommonPropertyTables Node.dat.<timestamp>

To run the export utility:

1 Open a command prompt at the system level.

2 Navigate to the {DPIPE_HOME} /scripts directory.

3 Type the following command:

trend_proc -f CommonPropertyTables_ exportdata.pro

Changing Detfault Directories

Common Property Tables creates a default directory reserved for property import and
property export files. The import utility looks for files in this directory, and the export utility
stores files in this directory. You are not required to establish a different directory. However, if
changing the default directory is necessary, these are the tasks you would need to perform:

e Task 1: Create a new directory for import and export files
e Task 2: Provide the import utility with the path to the new directory
e Task 3: Provide the export utility with the path to the new directory

You can use the same directory for import and export files, or you can set up separate
directories for import and export files.

Changing the Default Import Directory

The default directory for data property files, the location where the import utility will look for
your edited files, is specified by the SourceDirectory path. This path appears in the following
TEEL files:

® CommonPropTablesCustomer.teel
® CommonPropTablesHosts.teel

® CommonPropTablesLocation.teel
® CommonPropTablesNode.teel

If you are changing the default directory before you install the Common Property Tables
package, you can locate the TEEL files in the CommonPropertyTables.ap directory. If you
want to change the default directory after running Package Manager, you must change the
path information in two directories:

Chapter 3



® CommonPropertyTables.ap

L4 {DPIPE_HOME}/lib

To change the SourceDirectory, do the following:
1 Create the new source directory.

2 Navigate to the appropriate directory and open the directory. (See the discussion in the
preceding section about which directories are involved.) You will see the following files:

® CommonPropTablesCustomer.teel

® CommonPropTablesHosts.teel

® CommonPropTablesLocation.teel

¢ CommonPropTablesNode.teel
3 Double-click the CommonPropTablesCustomer. teel file.
4 Locate the line beginning with: SourceDirectory =

5 Change the path, replacing the existing path with the complete path to the new directory;
begin the new path name just after the equals sign ( =).

6 Make the same change in these files:
® CommonPropTablesHosts.teel
® CommonPropTablesLocation.teel

¢ CommonPropTablesNode.teel

’ Leave the file filters as specified in the original SourceDirectory.

Changing the Default Export Directory

To change the default export directory, modify the export data process file. If you are making
this change before you install the package, you must make this modification only once, in the
CommonPropertyTables.ap directory. If you are making this change after you run Package
Manager, make this modification in two places:

® CommonPropertyTables.ap
e (DPIPE HOME}/scripts
Follow these steps to change the default export directory:

1 In the CommonPropertyTables.ap directory, edit the
CommonPropertyTables exportdata.pro file. See sample file below.

2 Locate the three trend_export statements and, beginning at the bracket after the -o,
replace the existing path with the complete path to the new directory.
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3 Only if necessary—only if you have already installed this package—navigate to the
{DPIPE HOME}/scripts directory and make the same changes you made to
CommonPropertyTables exportdata.pro

Package: Comnoh Property Tables

Purpose: Exports property data for Customers, Regionzs and Nodes

into tab delimited filez to allow the user to modify existing
property walues. Then using the CommonPropertyTables importdata.pro
file to update the existing property values with the modified wvalues.

R H: - H: H:

R R A A R R R A A A B R R R

bhegin: exportdata nuwaiﬂ

{DPIPE HOME}/bin/trend export -o ¥ -p 10000 -a n -o {DPIFE HOME}/packages/CommwonProperty
{DPIPE HOME}/bin/trend export -c ¥ —-p 10000 -a n -o {DPIPE HOME}!/packages/CommonProperty
{DPIPE_HCME}/bin/trend export -o ¥ -p 10000 -a n -o {DPIPE_HOME!/packages/CommonProperty

end: exportdata

Changing the Default Run Time

The default run time for the automatic import process is 12:00 midnight. Follow these steps to
change the default:

1 Inthe {DPIPE HOME}/1lib directory, edit the trendtimer.sched file.

2  Scroll down the file and locate the line that defines the interval and offset for the
trend_proc that executes the CommonPropertyTables_importdata.pro command.

3 Modify the offset indicator. The offset indicator is the number after the plus (+) sign. For
example, if you change 24:00 to 18:00, the import utility will run at 18 hours after
midnight, or 6:00 p.m.
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4  User Input Forms

The node, customer, and location objects maintained by Common Property Tables can be
modified in two ways:

e By using the input forms discussed in this chapter
¢ By using the import and export utilities discussed in the next chapter

The input forms allow you to create new objects for customers, locations, and nodes and
modify existing objects. Using the forms is appropriate when you are adding or updating just
a few objects. The batch-oriented utilities are more efficient when many entries are involved.

“Create New” Forms

The Create-New forms allow you add new objects to the database. Follow these steps to
launch a create-new form.

1 Click the Objects icon in the panel on the left side of the Management Console window.
The Object/Property Management view opens.

2 Click the New icon in the tool bar, or select File > New... from the menu. The Create
Managed Object window opens.

Create Managed Object Ed

Create a new managed object.

Marne I Descripkion I

Creake Mew Cuskomer
Creake Mew Location
Create MNew MNode

3 Select an option and click Create at the bottom of the window.

Create New Customer

To add a new customer, type a customer name and a description. If you are entering only one
customer, click OK. The customer will be added and the window will close. If you have more
customers to add, click Apply. The customer will be added, the form will be cleared, and the
form will remain open for the next customer.

Keep the following rules in mind when using the Create New Customer form:
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¢  You must supply a name to create a new customer object.

¢ The customer name must be unique; you cannot have two customer objects with the same
name.

e Ifa description is not specified, it will be set to the customer name.

Common Property (ﬁfn

Create New Customer s

Thisform allowes 8 new customer to be created. Enterthe name of the new
customer; the description is optional. Click the Ok button to create the
customer and close the window. Click the Apply button to create the customer
and leawe the window open to create additional custamers. Click the Cancel
button to cancel.

Hame I

De=scription I

Last Created Customer

11} Customer Hame
1 FNE, Ine,
0] 4 AEml Cancel

Create New Location

To add a new location, enter a location name and a description. If you are entering only one
location, click OK. The location will be added and the window will close. If you have more
locations to add, click Apply. The location will be added, the form will be cleared, and the form
will remain open for the next location.

Keep the following rules in mind when using the Create New Location form:
¢ You must supply a name to create a new location object.

¢ The location name must be unique; having two location objects with the same name is not
permitted.
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e If a description is not specified, it will be set to the location name.

& /admin/CommonPropForms;/create_location.frep

Common Property (ﬁB

Create New Location e A

Thiz form allowes 3 new location to be created. Entarthe name of the new
loczation; the description is aptional. Click the OK button to create the
location and close the window, Click the Apply button to create the lacation
and leawve the mindow apen te create additional lecations. Click the Cancel
button to cancel.

Hame I
Description I
Last Created Location
1D Location Hame
1 London
oF; Apply

Create New Node

User Input Forms

To add a new node, enter a node name and any other information you may have. To assign a
node to a customer or a location, click the customer or location drop box and select the desired
entry. If you are entering only one node, click OK. The node will be added and the window will
close. If you have more nodes to add, click Apply. The node will be added, the form will clear,
and the form will remain open for the next node.

Keep the following rules in mind when using the Create New Node form:

¢ You must supply a name for the node to create a new node object. The name can be its
DNS name or its IP address.

¢ The name you supply must be unique; you cannot create a new node with the same name
as an existing node.

* A node can only be assigned to pre-existing customers and locations. If you want to assign
a node to a customer or location that does not exist, you must first add the customer or
location using the New Customer or New Location form.

e If a description is not specified, it will be set to the node name.

Creating a new node via this form will not automatically result in data
collection. To initiate SNMP collections, the same node must be defined in
Polling Policy Manager and added to a polling group. See the PI
Administration Guide for more information on Polling Policy Manager.
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B /admin/CommonPropForms/ create_node.frep

Common Property (ﬁﬂ

Create New Node i

This form allowes a new node to be created. The node name iz mandatony,
while the other fields are optional. Click the O button to create the node
and close the window. Click the Apply buttan to create the node and leawve
the window apen to create additional nodes. Click the Cancel button to
cancel.

Hode Hame

IP Address

Type

Make

Serial Humber

Operating System

Department

Description

|
|
|
|
Model |
|
|
|
|

Customer Hame ICustu:umer nas=igned ll

Location IL::u:ati-:un Unazsigned ll

Last Created Hode
Central ACME.com

Cancel

(] 4 Al

“Update” Forms

The update forms modify properties for customer, location, and node objects that already exist
in the database. To launch an update form, click the Objects icon in the panel on the left side of
the Management Console window. The Object/Property Management view opens.
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Object Manager will present you with a list of objects. The type of object presented depends on
which Object Manager view is open. The default view is the Device view, showing a list of
devices. The Customer view shows a list of customers, and the Location view shows a list of
locations. To change the view, select View > Change View and use the pop-up window to select a
different view.

When the type of object you are interested in updating displays, select the particular object
you would like to update. When you select the object, Update <Object Type> Information will
appear under Object Specific Tasks. Double-click the update task to open the appropriate
update form.

Update Customer

To update customer information, type the changes in the fields provided. The ID is a reference
number and cannot be changed. When changing the customer name, do not change it to
another existing customer name. Having two customer objects with the same name is not
allowed. To save your changes, click Apply. When you finish making changes, click OK. Your
changes will be saved and the window will close.

& /admin/CommonPropForms/update_customer.frep

Common Property (ﬁ/)

Update Customer Information inven:

This form allows customer information to be updated. Click the Apply button
to sawe any changes. Click the Cancel buttan to cancel any changes. Click
the OK button to sawve changes and close the form.

I |2u

Hame I.&.CME

Description I.&.CME

(04 Apply Zancel

Update Location

User Input Forms

To update location information, type the changes in the fields provided. The ID is a reference
number and cannot be changed. When changing the location name, do not change it to
another existing location name. Having two location objects with the same name is not
allowed. To save your changes, click Apply. When you finish making changes, click OK. Your
changes will be saved and the window will close.
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F fadmin/CommonPropForms,/update_location.frep

Common Property ﬁ/ﬂ

Update Location Information inven:

Thiz farm allows location information to be updated. Click the Apply button to
zawe any changes. Click the Cancel button to cancel any changes. Click the
Ok button to zave changes and close the farm.

ID |3|:|

Hame INEW ark

Description INEW ark

o] 4 Apply Zancel

Update Node

To update node information, type the changes in the fields provided. The node name cannot be
changed. To assign a node to a different customer or location, click the customer or location
drop box and select the desired entry. To save your changes, click Apply. When you finish

making changes, click OK. Your changes will be saved and the window will close.
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|
5 Property Import Files

The import utility reads the following tab-delimited flat files:
¢ (Customer data file

e Location data file

e Hosts data file

¢ Node data file

If the data that needs to be in these files already exists in a provisioning system, you can
probably generate each flat file automatically by writing a script and exporting the data
directly from the provisioning system database. If you cannot generate the file automatically,
you must create it yourself. You may create it using a spreadsheet program such as Excel, or a
text editor such as Notepad.

You can also generate customer, location, and node property import files by running the
property export utility that comes with the Common Property Tables package. However, this
approach to updating property information works only if the property tables were populated
by a datapipe. If you run the export utility and notice that the export file is empty, the
property tables are empty.

File Generation Guidelines

Whether you are exporting the data from a database or creating your own property import
files, produce a separate file for customer, location, hosts, and node information and follow
these guidelines:

¢ The sequence of columns, shown in the format tables below, is important. Adhere to this
sequence.

¢ Do not use values reserved for use by PI.
e Do not embed tabs in quoted text strings.

e Ifyou are using a spreadsheet program, save each file as a tab-delimited file. If you are
using a different method, be sure to enter a tab between columns.

e Give each input file the proper file name and save files to the directory where the import
utility expects to find them.
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The required file names are listed in the following table.

Customer CommonPropertyTables_Customer.dat
Location CommonPropertyTables_Location.dat
Host CommonPropertyTables_Hosts.dat
Node CommonPropertyTables_Node.dat

If you are using the default SourceDirectory path, save your property data files to:

{DPIPE HOME}/data/PropertyData

If you changed the SourceDirectory path, copy the files to the new directory.

Format of the Import Files

This section describes the format of the customer, location, hosts, and node data files. Make
sure the sequence of columns in your files is correct—the same exact sequence shown here—
and make sure you do not use values that are reserved by PI. If you were able to export data
from a provisioning system database and specify the proper column sequence, most of your
work is already done and your only task is to verify that reserved values are used correctly.

Customer Data File

The customer data file contains three columns separated by tabs. Each row represents one
customer. See below for a description of each column.

1 Unique integer value for each customer. This value is
known as “cust_id.”
2 The name associated with the customer ID.
3 A description of the customer.
Restrictions

Follow these rules when you prepare the customer data file:

Do not include column headers in your file. The first entry in your file should be an actual
customer ID, not “cust_id.”

Reserved values for column 1 (cust_id) are: -2, -1, 0.

If the cust_id string was exported from the K_Customer property table, do not change it.
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¢ Ifyou are adding a new customer to K_Customer, the value in column 1 (cust_id) must be
different from all existing cust_id values.

e Ifyou use an existing cust_id value (a value that matches the cust_id value of an existing
customer), you will overwrite that cust_id’s data.

e Since conflict with cust_ids that were automatically assigned by a report pack or datapipe
is possible, try to use high numbers in column 1. For example, you could begin with 10,000
and go up from there.

Location Data File

The location data file contains three columns separated by tabs. Each row represents one
location. See below for a description of each column.

1 Unique integer value for each location. This value is
known as “location_id.”

2 The name associated with the location ID.

3 A description of the location.

Restrictions

Follow these rules when you prepare the location data file:

¢ Do not include column headers in your file. The first entry in your file should be an
integer value for a location ID, not “location_id.”

e Reserved values for column 1 (location_id) are: -2, -1, and 0.

e Ifthe location_id string was exported from the K_Location property table, do not change
it.

e Ifyou are adding a new location to K_Location, the value in column 1 (location_id) must
be unique; that is, it must be different from all existing location_id values.

e Since conflict with location_ids that were automatically assigned by a report pack or
datapipe is possible, try to use high numbers in column 1. For example, you could begin
with 10,000 and go up from there.

Hosts Data File

The hosts data file contains a one-to-one mapping of IP address to host name. This can be the
system HOSTS file or a file with the same format as a system HOSTS file. The file contains
two columns separated by a tab. Each row represents one device. See below for a description of
each column.

1 IP address

2 Host name
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Restrictions

Follow these rules when you prepare the hosts data file:

Node Data File

Do not include column headers in your file. The first entry in your file should be an
integer value for a location ID, not “IP address.”

Each IP address and host name should be listed only once. Only the first occurrence of an
IP address or host name will be imported; subsequent occurrences will be ignored.

If an IP address had previously been mapped to a host name, importing it mapped to a
different host name will make the previous mapping invalid. Only the latest mapping will
be considered valid.

The node data file contains 15 columns separated by tabs. Each row represents one node. See
below for a description of each column.

1

A unique text string that matches the node name or the
node IP address.

Note: The node name, if the name is resolvable, or the
node IP address.

The node reference number specified by the user.
Note: This number is known as “node_id.”

Note: This column is not used; it is preserved to
maintain compatibility with earlier versions.

The node IP address.

(%)

The node type. Initially, this should be set to host. Other
node types will be added in the future.

A description of the node composed by the user.

The manufacturer of the node.

Node model type.

© | 0| 3| S

Node serial number.

Node operating system.

11

A name defined by the customer for the department
where the node resides.

12

The ID number for the customer who owns the node; in
other words, cust_id. This value establishes a link
between the node and a customer in the K_Customer
property table.

Note: Default cust_id = -2.
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13 The ID number for the location of the node; in other
words, location_id. This value establishes a link between
the node and a location in the K_Location property table.

Note: Default location_id = -2.

14 Customer name associated with cust_id.

15 Location name associated with location_id.

The customer name and location name columns are not necessary and are supported as a
convenience for the user when specifying cust_ids and location _ids that are not defined in the
K_Customer and K_Location common property tables.

If a new customer_id or location_id is specified for a given node, that cust_id/location_id will

be inserted into the K-Customer or K-Location table along with the specified customer name
or location name. If the customer name or location name is not specified, the name will be set
to Undefined Customer or Undefined Location, as appropriate.

Restrictions

Follow these rules when you prepare the node data file:
¢ Do not include column headers in your file.
e Ifanode name was exported from the K_Node Common Property Table, do not change it.

e Ifyou want to add a new node to the node property table, the text string in column 1 must
be unique and it should be set to the node name (if available) or the node IP address.

e Ifthe text string in column 1 is not unique—that is, if the text string matches an existing
value for node name—the other columns of your data file will overwrite the corresponding
row in the common property table.

Import Files and Property Tables

The import file on the left updates the table on the right.

CommonPropertyTables_Customer.dat K_Customer
CommonPropertyTables_Location.dat K_Location
CommonPropertyTables_Node.dat K_Node
CommonPropertyTables_Hosts.dat K_Node

When you want to modify existing information in a property table, values must match exactly.
If you are modifying a row in the K_Customer table, the cust_id values in the property file and
the property table must match. Similarly, if you are modifying a row in the K_Location table,
location_id values must match, and if you are modifying values in the K_Node table, node
name values must match.
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If the property import file introduces an existing value—that is, an existing cust_id,
location_id, or node name value—the other values in the row from the property data file will
overwrite the corresponding row in the common property table. If the property data file
introduces a new value, a new row and keyid value will be inserted in the property table.
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6 Columns in Property Tables

The Common Property Tables package creates the following property tables:
e K Customer

e K Location

e K Node

Each table is described below.

K_Customer

The K_Customer property table contains customer-specific information. This table maintains
customer ID, name, and description only. However, it can be expanded to support additional
customer information (for example, address) if needed.

dsi_key_id Unique value automatically assigned

dsi_target_name | Always set to “0” for customer information

dsi_table_key Set equal to cust_id

dsi_descr Customer definable
cust_id Unique reference number for each customer
cust_name Customer name associated with cust_id
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K_Location

The K_Location property table contains location-specific information. This table maintains
location id, name, and description only. However, it can be expanded to support additional
location information if needed.

dsi_key_id

Unique value automatically assigned

dsi_target_name

Always set to “0” for location information

dsi_table_key

Set equal to location_id; if the location information is
not pre-provisioned, dsi_table_key will equal dsi_key_id

dsi_descr

Customer definable

location_id

Unique reference number for each location; if the
location information is not pre-provisioned, location_id
will equal dsi_key_id

location_name

Location name associated with location_id

K_Node

The K_Node property table contains node-specific information. A node is any network device
(computer, router, switch) capable of being polled for performance data.

dsi_key_id

Unique value automatically assigned

dsi_target_name

Always set to “0”

dsi_table_key

Set equal to node_name.

dsi_descr

Customer definable

node_id

Customer-assigned reference number for each node

node_name

Name of node; the DNS name or the IP address

node_type Type of node; only valid type = Host
IP_address Node IP address

make Node manufacturer

model Node model type

serial num

Node serial number

operating_sys

Node operating system

department

Customer-defined name for node department
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sysObjectID MIB II system object ID — not currently used

cust_fk Foreign key pointing to table K_Customer; default
value points to default K_Customer row

location_fk Foreign key pointing to table K_Location; default value
points to default K_Location row

IP_state Flag indicating if the IP address node name mapping is
the most recent mapping for the IP address

Columns in Property Tables



36

Chapter 6



Index

Symbols
$DPIPE_HOMEdatalmportData, 9, 14
$DPIPE_HOMEdataPropertyData, 9, 14

C

CommonPropertyTables_delete_nodes.pro, 11
Customer Data File, 28

D
default directories, 18

defaults
export directory, 18, 19
import process run time, 20

deleting nodes from ksi_managed_node, 11
deleting nodes from property tables, 11

directories
scripts, 17, 18

E

ee_collect, 20
environment variable, 14
export data command, 18

export file timestamps, 18
export utility, 21, 22, 23, 25, 26

|
import utility, 17

K

K_Customer, 33
K _Host, 33
K_Location, 34

L
Location Data File, 29

N
Node Data File, 30

P

property data tables
RcomPropTab_Customer, 28
RcomPropTab_Host, 28
RcomPropTab_Location, 28

property export utility, 27

Q

quotation marks, 27

T

TEEL files
CommonPropTablesCustomer.teel, 18
CommonPropTablesHost.teel, 18
CommonPropTablesLocation.teel, 18

trend_export, 18
trendtimer.sched, 20

U
UNIX directory, 14

37



38



We appreciate your feedback!

If an email client is configured on this system, by default an email window opens when you
click on the bookmark “Comments”.

In case you do not have the email client configured, copy the information below to a web mail
client, and send this email to docfeedback@hp.com
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Document title:
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Feedback:


mailto:docfeedback@hp.com




S,
—

Java~

invent COMPATIBLE



	User Guide
	Contents
	1 Overview
	Enhancements and Fixes
	Nightly Delete Process
	Sources for Additional Information

	2 Package Installation
	Guidelines for a Smooth Install
	Software Prerequisites
	Upgrading to Version 3.9
	Directory Structure
	ImportData and PropertyData Directories

	Installing Common Property Tables 3.9
	Package Removal

	3 Import and Export Utilities
	Import Utility
	Export Utility
	Changing Default Directories
	Changing the Default Import Directory
	Changing the Default Export Directory

	Changing the Default Run Time

	4 User Input Forms
	“Create New” Forms
	Create New Customer
	Create New Location
	Create New Node

	“Update” Forms
	Update Customer
	Update Location
	Update Node


	5 Property Import Files
	File Generation Guidelines
	Format of the Import Files
	Customer Data File
	Restrictions

	Location Data File
	Restrictions

	Hosts Data File
	Restrictions

	Node Data File
	Restrictions


	Import Files and Property Tables

	6 Columns in Property Tables
	K_Customer
	K_Location
	K_Node

	Index

	We appreciate your feedback!
	Comments



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (None)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.5
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings false
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Preserve
  /UCRandBGInfo /Preserve
  /UsePrologue true
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
    /Courier
    /Courier-Bold
    /Courier-BoldOblique
    /CourierNewPS-BoldItalicMT
    /CourierNewPS-BoldMT
    /CourierNewPS-ItalicMT
    /CourierNewPSMT
    /Courier-Oblique
    /Futura-Bold
    /Futura-Book
    /Futura-BookItalic
    /Futura-Heavy
    /Futura-Light
    /Futura-Medium
    /Futura-MediumItalic
    /Garamond
    /Garamond-Bold
    /Garamond-Italic
    /Helvetica
    /Helvetica-Bold
    /Helvetica-BoldOblique
    /Helvetica-Narrow
    /Helvetica-Narrow-Bold
    /Helvetica-Narrow-BoldOblique
    /Helvetica-Narrow-Oblique
    /Helvetica-Oblique
    /NewCenturySchlbk-Bold
    /NewCenturySchlbk-BoldItalic
    /NewCenturySchlbk-Italic
    /NewCenturySchlbk-Roman
    /Symbol
    /SymbolMT
    /Times-Bold
    /Times-BoldItalic
    /Times-Italic
    /Times-Roman
    /Webdings
    /Wingdings2
    /Wingdings3
    /Wingdings-Regular
    /ZapfDingbats
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 600
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /SyntheticBoldness 1.000000
  /Description <<
    /ENU ()
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice




